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Introduction 

This tutorial assumes you are running the latest release of version 7.2.3 of the 
EFILive Tuning Tool software. 

The Custom Operating Systems supplied by EFILive are provided “as is” without 
warranty of any kind. Please take all reasonable caution when using the extended 
features of EFILive’s Custom Operating Systems. 

You may return your PCM to its GM factory condition at any time, by reflashing a 
stock GM Operating System and calibration over the top of any EFILive Custom 
Operating System. 
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Upgrading to an EFILive Custom Operating System 

Step 1 

Upload and save to a *.tun file, the current tune from the PCM (or open a *.tun file 
copy of your PCM) and note the Operating System number. 

You will need this *,tun to restore the PCM’s calibrations after installing an EFILive 
Custom Operating system. 
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Step2 

Using the table on the next page, find the EFILive Custom Operating System that 
matches your PCM’s current Operating System number. 

The xx at the end of each filename may be 01, 02, 03, … ,99 and indicates the 
version number and feature-set of the EFILive Custom Operating System. 

 

EFILive Custom Operating System version numbers contain the following features: 

Version Feature Set 

01  Dual spark map speed density enabled. 

02  Dual spark map speed density enabled. 

 Valet option. 

03  Dual spark map speed density enabled. 

 Valet option. 

 2 and 3-bar forced induction enabled, but will 
still work on 1-bar systems. 

 Open-Loop, RPM/MAP based fuel control. 
(on selected operating systems) 

 

 

If your Operating System is not listed (i.e.1999 and 2000 model years), you may 
use one of the 2001, 2002 Operating Systems. Unfortunately, it is not possible to 
upgrade your calibrations to the new Operating System. If you upgrade the PCM 
to a later year, you will need to re-tune your PCM for that Operating System.  

Note: The listed year in the table below refers to the year the PCM operating 
system was first released and then the various revisions of the first release, not 
the model-year of the vehicle. Eg, 12202088 was the first release for 2001, 
12225074 was the last. 
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EFILive Custom Operating Systems 

 

GM Stock 
Operating System 

EFILive Custom 
Operating System 

2001 

12202088 012500xx 

92111922 012500xx 

12208322 012700xx 

12225074 012900xx 

2002 

12209203 020100xx 

12212156 020200xx 

12221588 020300xx 

12593358 020400xx 

2003 

12585318 031100xx 

12577216 031300xx 

12579405 031500xx 

12585318 031700xx 

12593058 031900xx 

2004 

12509967 040300xx 

12583506 040800xx 

12587604 041100xx 

12588804 041200xx 

12591347 041300xx 

12592433 041400xx 

12585950 040729xx 

12587603 040730xx 

12592425 040731xx 

2005 

12592618 051200xx 

12593555 051300xx 
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Step 3 

Open the *.tun file from the above list that matches the EFILive Custom Operating 
System to which you want to upgrade, then perform a full reflash of that *.tun file 
into the PCM.  

When the full reflash is finished, the PCM will be left in dead poll that prevents the 
engine being started. 

Step 4 

Open the *.tun file that you saved in step 1. It contains the PCM’s calibrations from 
before the EFILive Custom Operating System was installed. Perform a calibration 
only reflash of that *.tun file. 

At this stage, the PCM is capable of starting and running your engine. However, 
don't get too excited just yet, there are a few more steps that must be completed. 

Step 5 

Read the PCM again and save the results in a new *.tun file – use the menu option 
File->Save as… 

Step 6 

IMPORTANT 

Open the first segment in the Navigator, called EFILive Custom Calibrations, 
and confirm that the values look “sane”. 

GM sometimes fills blank areas of the flash chip’s memory with zeros and 
sometimes with ones. That can alter the default settings of the parameters in the 
EFILive Custom Calibrations segment.  

You must change these values to “sane” values. The values that you select now 
are just initial settings; you will be able to fine-tune them later. 

Go through the entire list of EFILive Custom Calibrations parameters and set 
them to the following: 

 {A0000} Forced Octane Scaler: Disabled  

 {A0001} Forced Octane Scaler Percentage: 100%  

 {A0002} Octane Scaler Limiter: 100% 

 {A0011} PCM Input #1 Function: Not used 

 {A0012} Valet Mode Speed Limit with ETC: Max Setting 

 {A0013} Valet Mode Speed Limit non ETC: Max Setting 
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{A0008} Open Loop ECT Commanded Fuel Multiplier 

This calibration is a multiplier for the values in the new {B3647} and {B3649} 
Commanded Fuel vs RPM calibrations; it adjusts the commanded fuel values 
based on coolant temperature.  

The values shown are just an example 

 

IMPORTANT 

You must at least fill this table with 1.00, if this is set to 0.00 the engine will not 
run, if it is set too high the engine will run very rich. Setting this to 1.00 means no 
additional enrichment will be added from this table. You may find that you don’t 
ever need to alter any of these from 1.00. 
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{A0009} Boost VE calibration – part 1 

Depending on the PCM’s default memory configuration (zeros or ones), this 
calibration may be set to all zeros or all maximum values. 

Copy the last column from the {B0101} VE calibration into the first column of the 
boost VE map. 

Do this by highlighting the last column (105kPa) in the {B0101} VE calibration, 
then select menu option: Edit->Copy, then in the {A0009} Boost VE calibration, 

select the top left cell (at 400rpm, 105kPa) and select the menu option Edit-
>Paste. 

 

 

 

Page 17 has further explanations on how to set up for boosted applications. 
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{A0009} Boost VE calibration – part 2 

Paste the same values into the last column of the {A0009} Boost VE calibration by 
selecting the top cell of the last column and selecting menu option Edit->Paste. 

Then, with the last column of cells still selected, increase their value by 300%. To 
do that, enter the value 300 into the Adjust text box and click the [%] button. 

Now select the entire table by clicking the upper-left, blank, grey cell then select 
the left to right linear-fill toolbar button (shown in the red square). 

 

 

That will fill the entire table with values from 105kPa to 285kPa like the map below. 
This should only be considered as a preliminary boost VE map. 
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{A0010} Boost timing calibration 

Fill this table with zeros for now. To set the entire table to zero, select the entire 
table by clicking the upper-left, blank, grey cell. Enter zero into the Adjust text box 
and click the [#] button. 

Remember, the values in this calibration will be subtracted from the final timing 
value. 

This calibration works in conjunction with {B5956} Coolant Temp Spark Multiplier, 

which must have a value of 1.00 wherever you want boost retard active. 

Page 17 has further explanations on how to set up for boosted applications. 

 

 

{A0014} Intake air temperature VE multiplier 

Fill this table with 1.00 for starters. 

To set the entire table to 1.00, select the entire table by clicking the upper-left, 
blank, grey cell. Enter 1.00 into the Adjust text box and click the [#] button. 

The purpose of this table is to allow the PCM to adjust the commanded fuel by 
multiplying the VE table values based on the intake temperature. As an example, if 
your VE table has been mapped with an intake temperature around 70°F (25°C) 
then you may find once the intake temperature rises to say 122°F (50°C) then the 
actual AFRs at which the engine is running, may not match what they were when 
the intake temp was cooler. 

To determine the amount you need to multiply the VE table by you can use the 
following example as a guide. 

At 70°F (25°C), full throttle, the commanded AFR is 13.0:1 and the measured AFR 
is 13.0:1 so no correction is needed in this case the table will have 1.00, then at 
122°F (50°C) the commanded AFR will still be 13.0:1 but the measured AFR might 
now be 13.65:1, which is an error of 5% so you need to multiply the VE table 
numbers by 5%. In this example you would enter in 1.05 into the IAT cell closest to 
122°F (50°C). If it were 10% out, you enter in 1.10. 

This table should only be used once the VE table has been fully mapped at a 
stable intake temperature. You may never need to alter this table, in which case 
please leave all the values at 1.00 
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{B3647} Commanded Fuel vs RPM (Normal) 
and 
{B3649} Commanded Fuel vs RPM (Ethanol) 

In some Custom Operating Systems the {B3647} and {B3649} Commanded Fuel 
vs RPM calibrations have been changed from GM’s ECT vs MAP to EFILive’s 
RPM vs MAP. This gives you total control over the commanded fuel for all MAP, 
RPM and fuel types. As a starting point, you should configure the data, in both 
tables, similar to what is shown below. 

 

 

 

IMPORTANT 

To control the fuelling exclusively via this calibration, you must also configure: 

Engine->Fuel->Trim. 

 {B4205} Closed Loop Temp Enable: Set to max setting 

Engine->Fuel->O2->Parameters. 

 {B4108} STFT Idle Enable: Disable 
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In EFILive’s 2 and 3-bar Operating Systems, power enrichment (PE) mode can be 
prevented all the way up to full boost.  If you are using the {B3647} and {B3649} 
Commanded Fuel vs RPM calibrations as shown above, then there is no need for 
PE mode below 100kPa. Above 100kPa, the PCM will continue to command the 
value in the rightmost column of the {B3647} and {B3649} Commanded Fuel vs 

RPM calibrations. You could then have PE mode activate at say, 150kPa to 
command a richer AFR. 

Page 17 has further explanations on how to set up for boosted applications. 

In this table the PCM will average the values between cells, this means in this 
table the commanded fuel between 95kPa and 100kPa will be somewhere 
between 13.8:1 AFR and 12.5:1 AFR (AFR values shown, NOT EQ Ratio). 
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IMPORTANT 

You have now completed the EFILive Custom Operating System upgrade. 

Save the tune in a new *.tun file – use the menu option File->Save as… which will 
automatically increment a sequence number on the end of the file name. Each 
time you alter the calibration use File->Save as… That way you create a 
sequenced history of changes, through which you can backtrack should something 
go wrong. 

This *.tun file will become your “base calibration” for the upgraded Operating 
System. Always keep a copy of this file in case you need to restore your PCM to 
its initial Custom Operating System state. Preferably, make a backup of it onto a 
CD and store it in a safe place 
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Wiring your PCM for valet mode 

Valet mode is available in Custom Operating Systems from version 02 onwards. 

To activate Valet mode, wire in a hidden switch that commands the PCM to use a 
configurable, lower vehicle speed setting for fuel cut-off (or ETC close). 

If you wish to use valet mode as an RPM based cut only then set the Valet mode 
speed limiters to the maximum value. 

CAUTION 

The Valet mode RPM limiting uses fuel cut-off to limit the engine RPM, it does not 
use spark cut. It is not recommended you hold the engine on the RPM fuel cut for 
very long as the engine can run lean and damage the engine itself and/or catalytic 
converters, use it sensibly.  

The Valet mode must be activated in the calibration before the switch will have any 
effect. 

Set: 

 {A0011} PCM Input #1 Function: Valet Mode 

 {A0012} Valet Mode Speed Limit with ETC: Desired speed limit 

 {A0013} Valet Mode Speed Limit non ETC: Desired speed limit 

 {B3324} Valet Mode RPM Upper Limit:            Desired RPM upper limit 

 {B3325} Valet Mode RPM Lower Limit:            Desired RPM lower limit 
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Setting up the calibrations for 2 and 3-bar operation 

2 and 3-bar boost is available in some Custom Operating Systems from version 03 
onwards. 

Configuring a 2 or 3-bar MAP sensor 

When the key is on but the engine is not running, the MAP sensor reads the 
barometric air pressure, usually 101kPa (14.7psi). When tuning in high altitude 
areas it is worthwhile reading the MAP values (using EFILive’s Scan Tool) at 
key-on with the standard 1-bar sensor to obtain the barometric pressure at the 
current altitude. 

After fitting your 2 or 3-bar MAP sensor, you must rescale the MAP sensor. 

Engine Diagnostics->MAP->Parameters 

 {C6301} MAP Sensor Scaler: 2-bar sensor: 190 

3-bar sensor: 288 

These values will get the MAP scaler’s value close to what it needs to be, you will 
then need to adjust it (by small amounts) until the MAP sensor reads the same 
barometric pressure that your standard 1-bar sensor was reading at key-on, 
engine-off. 

Logging boost levels in the Scan Tool must be performed with the PID ‘SAE.MAP’. 

 

Change {C5501} MAP Rationality Test RPM High (RPM) to 2000RPM.  
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Going MAFless 

When fitting a 2 or 3-bar MAP sensor you must disable the MAF sensor. It is 
possible to leave the MAF sensor in place. This will need to be done on the 85mm 
MAF as the Intake Temp Sensor is located in the MAF housing.  Alternatively, you 
could relocate the IAT using on older style IAT sensor. Even with the MAF still in 
place, the PCM must be forced to ignore the MAF signal. 

To disable the MAF sensor: 

Set the Engine Diagnostics->Engine Diagnostics->MAF->Parameters: 

 {C2901}  MAF High Frequency Fail 1: 1Hz 

 {C2902}  MAF High Frequency Fail 2: 1Hz 

If calibration {C2902} is not available in the operating system that you are 
using, then ignore this step. 

 {C2903}  MAF High Frequency Fail Limit: 1 

 {C2907}  MAF Test Min Engine Speed: 300 RPM 

 {C2908}  MAF Test Min Run Time: 0.1 seconds 

Set the Engine Diagnostics->Engine DTC processing Enablers:  

 P0101 ‘C’ Non Emissions 

 P0102 ‘C’ Non Emissions 

 P0103 ‘C’ Non Emissions 

Set the Engine Diagnostics->Engine DTC MIL Enablers: 

 P0101 ‘No MIL’ 

 P0102 ‘No MIL’ 

 P0103 ‘No MIL’ 

 

When going MAFless and/or boosted on vehicles with Electronic Throttle Control, 
you will most likely need to increase {C6101} ETC Predicted Airflow, by significant 

amounts to stop the PCM going into reduced power mode. 

 

Set the 
Transmission Diagnostics->Transmission DTC Fault Max Pressure Enablers 

 P0101 ‘No’ 

 P0102 ‘No’ 

 P0103 ‘No’ 

Set the Transmission Diagnostics->Transmission Failsafe Enablers: 

 Set all airflow related enablers to ‘No’ to prevent the transmission from going 
into failsafe mode due to the MAF being disabled. 
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Barometer Compensation 

To prevent the PCM from learning barometric offsets while in boost, set the 
following calibrations. 
Engine Calibration->Barometer->Parameters: 

 {B0301} Min RPM for Barometer Update: 1200 RPM 

 {B0302} Max RPM for Barometer Update: 2000 RPM 

(or before high boost levels) 

If you do not expect to experience any significant changes in elevation, (i.e. 
barometric pressure) then set these values very high (like 7800 PRM) so the PCM 
will never perform barometric compensation. 

Boost VE Table 

The boost VE table MUST be populated with some valid numbers before you run 

the engine into boost. A good starting point is to copy the last 105kPa (31inHg) 
column into the first column of the {A0009} Boost VE table (which is described on 
pages 7 and 8 of this document). 

To be safe, put larger than expected values in here, remember it’s better to run too 
rich on the first dyno run than to run too lean, which can damage the engine. 

It is very important you never leave any cells at zero or set any cells to zero. If you 
do, the PCM will command ZERO fuel at those points, resulting in a dangerously 
lean condition. 

See also the {A0010} Boost Timing table brief on page 9 of this document. 
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Running in ‘semi’ Open Loop 

EFILive has re-designed the PCM’s Operating System to allow the {B3647} and 
{B3649} Commanded Fuel vs RPM calibrations to be used as the commanded 
fuel tables. If you use this table to control fuelling, there is no need for PE mode. In 
operating systems with this new table, the standard Open Loop table  {B3605} is 
no longer available.  

You can define any commanded fuel for any given RPM and MAP. When the 
engine’s fuelling is based on this new table, you must ensure the PCM will never 
go into full closed loop operation or this table will be ignored by PCM. 

The new {B3647} and {B3649} Commanded Fuel vs RPM calibrations have also 

been changed so that whenever an EQ Ratio of 1.00 (AFR 14.63) is commanded, 
the PCM will enter a semi closed-loop state. In that state the O2 sensors will be 
used for fuel trimming with STFT correction, useful for idle or part throttle. If any 
other EQ Ratio is commanded then the PCM will be in full open-loop operation 
with no O2 feedback and no STFT control. 

 That means you can command 13.5:1 AFR at part throttle or idle if you wish, or 
even 15.5:1 AFR at part throttle for greater fuel economy, in this state the O2 
sensors will be ignored. 

Remember to check what units this table is displaying. Do not enter values 
like 14.63 into a table that is displaying EQ Ratio. Likewise, entering a value 
of 1.00 into a table displaying AFR will result in a commanded AFR of 1:1. 

To always use the new {B3647} and {B3649} Commanded Fuel vs RPM 

calibrations: 

IMPORTANT 

Engine->Fuel->Trim. 

 {B4205} Closed Loop Temp Enable: Set to max setting. 

Engine->Fuel->O2->Parameters. 

 {B3801} Long Term Fuel Trim Correction: Disable 

Note: Long Term Fuel Trims will not work when using the new {B3647} and 
{B3649} calibrations. 

 

Several other STFT values may require adjustment: 

 {B4101} Closed Loop Idle Vehicle Speed 

 {B4102} Closed Loop Idle Vehicle Speed Hyst 

 {B4103} Closed Loop Idle Throttle Position 

 {B4104} Closed Loop Idle Throttle Position Hyst 

 {B4108} STFT Idle Disable 
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Boost and Spark 

If you observe significant spark retardation as you pass through 110-115 kPa 
MAP, the likely culprit will be torque management. You can confirm that by logging 
the PID {GM.EST_TRQ_DMA}. 

To prevent the torque management subsystem removing spark timing, change the 
following calibrations: 

Engine Calibration->Torque Limiting: 

 {B1902} Torque Loss from Spark Retard: Set to all zeros. 

Engine Calibration->Torque Limiting->Parameters: 

 {B6619} Max Torque, Trans Input Shaft: Maximum value. 

 {B6620} Max Torque, Trans Output Shaft: Maximum value. 
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Boost and Commanded Fuel 

Look again the new {B3647} and {B3649} Commanded Fuel vs RPM Calibrations, 

you will notice the MAP kPa values only go up to 100kPa, so what about boost? If 
the MAP is above 100kPa then the PCM will use the value at 100kPa for any 
boost level. If you need richer values above 100kPa, one of two methods may be 
used. 

Method 1: 

Increase the {A0009} Boost VE calibration values until the desired AFR is 
achieved. Doing this will mean the increased values in the {A0009} Boost VE 

calibration will no longer reflect the true VE of the engine. However, the 
increased values will force the PCM to add more fuel to keep up with the VE 
calibration’s increased airflow. 

Method 2: 

Enable PE mode for the boost level at which you want to richen the AFR. 

This can be done using parameter {B3613} PE MAP Threshold. Also, please 

make sure that all other PE mode parameters are within a normal range so 
that PE mode can become active. Some factory calibrations have PE mode 
disabled. 

This method gives you more control over the fuel mixtures as you can define 
the commanded fuel based on RPM once in PE Mode. You must be careful 
(if you are using PE mode to define your boost enrichment) that the PCM 
does not drop out of PE mode. If it does, the PCM will revert to the 
commanded fuel in the {B3647} and {B3649} Commanded Fuel vs RPM 

Calibrations. 

 

Logging boost levels (Manifold Absolute Pressure) in the Scan Tool must be performed 
with the PID {SAE.MAP}, the PID {GM.MAP} does not display boost correctly. 

One final note on the {B3647} and {B3649} Commanded Fuel vs RPM calibrations, you 
also need to use the new {A0008} Open Loop ECT Commanded Fuel Multiplier 

calibration to compensate for cold running conditions. See page 6 of this document for 
further details. 


